CS181DT Class 7: 3D Printing

UPLOAD COLLECTIONS MAKES CONTEST BLOG v (D) LoGIN

TOP DESIGN

STL FILES OF THE COMPLETE
CATALOGUE OF INFINITY TRAX,
THE MODULAR MAGNETIC
MARBLE RUN

Infinity Trax is a modular magnetic
marble run that can be built{and re-
built as many times as you want) on
metallic vertical surfaces such as
fridges or magnetic whiteboards. It's
part puzzle, part STEM toy, part art-
work, and a truly unique marble run

with more passible track designs than
there are atoms in the universe!
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& BEST COOL AND FUN 3D PRINTS TO MAKE WITH YOUR 3D PRINTER @ BEST 3D PRINTER FILES SELECTION FOR HALLOWEEN

https://cults3d.com/en homepage



https://cults3d.com/en

Class 7 agenda

» Zipcrit

* PM4 details

» Studio: OpenSCAD
* Importing + fixing existing STLs with MeshLab
* OpenSCAD basics, syntax
» Slicing & support generation in OrcaSlicer

* Break

» Design for Protest Seminar



To follow along in the studio...

* Download OpenSCAD - https://openscad.org/

» Download MeshLab - https://www.meshlab.net/

* (Optionally) Download OrcaSlicer - https://github.com/SoftFever/QrcaSlicer


https://openscad.org/
https://www.meshlab.net/
https://github.com/SoftFever/OrcaSlicer

PM4: 3D printing for protest

. . CS181DT
» “Capstone” project for the first

third of the course

Schedule
Instructors

* Not just about practicing your

Course Policies

making skills or learning

Assignment 1 - Hacking Zine

technologies, but now design

Making - Sensory Cardboard

Assignment 3 - Digital

motivated by users & reason

Assignment 4 - 3D Printing
for Protest

« We'll learn more about the
protest component in the
seminar

Canvas

Assignments |/ Assignment 4 - 3D Printing for Protest

Personal Making Assignment 4: 3D Printing for
Protest

Various 3D models found on Cults3D. Left to right, revolution, glacier organizer, Free Palestine keychains, grafitti caps.

This assignment may be done alone or in pairs. If in pairs, please contact the instructor with
the names of both students in the pair. | suggest making pairs based on similiar protest interests,
and you can use the class Slack to look for partners!

This assignment is due in 2 weeks to account for time needed on the 3D printer. Please start

early. For real: the makerspace has ~six 3D printers, and your print will take several hours to finish,
so you'll likely need to use late days if you wait until the last day since all the printers will be in use.

As suggested by our TAs, here's a spreadsheet where you can indicate your intention to use the 3D
printer for an at-a-glance look at their business.

This assignment is the “capstone” of the first third of the course and worth 150 points (instead of
the usual 100). As such, it is highly encouraged to submit your storyboard for feedback a week early
on 9/30.



Step 1: Storyboarding

Name of Project: Bog guéa’k Mebile ek I:‘W

» A storyboard visually
communicates context and use
of your design. What scenarios
will people use your object?
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* This is what the studio tutorial will be about

* Incorporating existing .STL (a common format for 3D
printing) files is allowed/encouraged, as long as you
modify them in some way

* You might have to fix them in MeshLab

* Your protest object doesn’t have to be 100% 3D printed,
it's fine to incorporate other materials/found objects.
However, some (non-trivial) part of it has to be 3D printed

* You are not required to use OpenSCAD if you have other
preferred 3D modeling tools, but OpenSCAD 3D models
with code so | figured it'd be the easiest to teach :)

» Unsure? Submit your storyboard next week for feedback!




Write up extras: justify your design

» How does your design address protest?

» Why does your object suit the 3D printed
medium, rather than other ones (like analog
or laser cut?)

» What are the limitations of 3D printing for
protest?

» Questions?

Step 4: Documentation & write up

Your PDF write up for this assignment should include, in addition to the design documentation, 3
written paragraphs addressing (1) some background of your protest, (2) justifying why your object is
3D printed and not some other medium, and (3) reflecting on the limitations of design for protest.
Specifically, create a PDF that contains in order:

A paragraph on background context of your protest. What/who are you protesting? Why do you
care about the issue?

Your storyboard showing the context and motivation behind the protest object.

A paragraph justifying why your object suits the 3D printed medium. Why is it better suited for 3D
printing rather than analog means or laser cutting?

Your design documentation of the process. Include at least:

One screenshot of your STL file (such as rendered on OpenSCAD)
One screenshot of your piece visualized in the slicer software
Two photos from two different angles of your final 3D printed object

A paragraph addressing the /limitations of your 3D printed object for protest. For instance, in
Printing Utopias, the author says, “On the one hand, the 3D printer helps make utopian desires
tangible and negotiable. On the other hand, the 3D printer tends to promote a techno-positivist
approach that oversimplifies social change, losing sight of alternatives and ambiguities.” This
echoes the Making versus Making Do reading—how does your object lie on this spectrum of
making a utopian desire tangible versus being techno-positivist? If you weren't forced to 3D print
something for this class assignment, would you still think your object helps in your protest, or
would the protest be better addressed through other, non-technology centric factors?

6 Acknowledgements: List any online resources you used, modified, or got inspiration from. Link
any STL files you downloaded and remixed. List any people (such as makerspace stewards) you
got help from. If you worked in pairs, please also write what specific parts of the assignment did
each person contribute to in this section.

Finally, the usual feedback/reflection paragraph: How long did you spend on this assignment?
How did this assignment match up to your initial expectations? What was the most challenging
part? What did you learn about interacting with 3D printers? Were there any parts you had to
redo, or lessons you learned for the future? And, as always, how is the workload of the class
matching to your expectations? (This assignment is our “midterm” equivalent!)



Studio: 3D printing
workflow demo




3D printing demo broad strokes

1. Download existing STL from Thingiverse to remix
» 2. Edit parametric example code in OpenSCAD (parametric = has parameters)

» 3. Fix “broken” STL in MeshLab

» 4. Generate support material in OrcaSlicer
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Elephant Phone Holder (No supports required)
,& Download all files ¥
unfilterd October 23,2014 & Remixed

Post amake Post aremix o Watch ®© Report thing P Tip designer ©

https://www.thingiverse.com/thing:512797



https://www.thingiverse.com/thing:512797

Protip: holding down ctrl + click pans the viewport
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31 echo(version=version(}); ECHO: version = [2021, *, 0] 1. Introduction
32 S/ Written by Marius Kintel <mariusgkintel.net> Cempiling desicn (CSG Products generation)... ? First Stons
83/ Beometries in cache: 110

34 // To the extent pecssible under law, the euthor(s) have dedicatec all Geometry cache siza in bytes: 3779772
35 [/ copyright and related and neighboring rights to this software @ CGAL Polyhedrons in cache: 13
tn tre e 2 g
i i i : i i . . CGAl cache size in bytes: 29954776
35 // public domain wecrldwide. This software is distributed without any - " N
37 // warranty. Cempiling desicn (CSCG Products normalizaticn)...

33 /f Normalized tree has 22 elements!

33 // You should have received a copy of the CC® Public Domain Compile and preview finished.

39 // Dedication along with this software. Total rendering tme: 0:00:C0.150

91 /! If nct, sez <http://creativecommons.org/publicdorain/zero/1.€/>,

Yiewpor:: translate = [ 1.17 -14.6€ -19.88 ], rotate = [ 87.20 341.10 1.90 ], cistance = 248,17, fov = 22.50 (936x506) OpenSCAD 2021.01

File > Examples > Basics > CSG-modules.scad https://openscad.org/documentation.html
Confused? Read the docs!!


https://openscad.org/documentation.html
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Vx[ Candle Stand 1%/
//Length of candle stand
length=50; // [70:large,50:medium,30:small]

// Center stand
cylinder(length,width-2);

OO~ HE WNM=

//Radius of ring of stand
9 radius=25;

11 /% [ Number of candle holders ]x/
12 // Number of candle holders
13 count=7; //[3:14]

15 //Do you want center Candle
16 centerCandle=true;

18 /% [ Candle Holder ]x/
19 //Length of candle holder
20 candleSize=7;

22 //Width of candle holder
23 width=4;

25 //Size of hole for candle holder
26 holeSize=3;

27

28 CenterCandlewWidth=4;

29

30 /x[Properties of support]x/
31

32 heightOfSupport=3;
33 widthOfSupport=3;

35 /*[Properties of Ring]x*/
37 height0fRing=4;

39 widthOfRing=23;

42 //Create center candle

43 translate([0,0,length-candleSize/2])
44 [Flif(centerCandle){

45 difference(){

46 $fn=360;

47 cylinder(candleSize, r=CenterCandleWidth);

48 cylinder(candleSize+1, r=CenterCandleWidth-2);
49 }

50 [F1}elsed

candleStand.scad

candle-modified.scad
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Compile and preview finished.

Total rendering time: 0:00:00.150
Loaded design '/Applications/
OpenSCAD.app/Contents/Resources/

examples/Parametric/candleStand.scad'.
Compiling design (CSG Tree generation)...

Compiling design (CSG Products
generation)...

Geometries in cache: 110

Geometry cache size in bytes: 3779712
CGAL Polyhedrons in cache: 13

CGAL cache size in bytes: 29954776
Compiling design (CSG Products
normalization)...

Normalized tree has 53 elements!

Viewport: translate = [ 3.01 13.14 43.36 ], rotate = [ 62.70 341.10 11.00 ], distance = 407.91, fov = 22.50 (645x501)

0 Error-Log

Show All 9

Group File Line

OpenSCAD 2021.01

File > Examples > Parametric > CandleStand.scad

Play around and see if you can
understand the parameters



STL file appearing in preview, not render - fix the STL file in MeshLab

»
TEeYgE s

=Py ~ wus Filters > Cleaning & repairing

Here, it was specifically fixing
non-manifold edges

p— In general, just click through
the options until you see it do

some action to >0
vertices/faces/edges

3D models are represented by vertices + faces
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/=[ Candle Stand ]/
//Length of candle stand
length=60; // [70:large,50:nedium,30:sma’l]

J//Radius of ring of stand
radius=25;

/= [ Number of candle holders ]/
// Number of candle holders
countr=4; //[3:14]

//Do you want center Candle
centerCandle=true;

Jx [ Candle Holder ]/
//Length of candle holder
candleS5ize=10;

J/Width of candle nolder
width=10;

J/Size of hole fTor candle holder
holeSize=width/1.5;

CentarCandleWidth=4;
Jx[Properties of suppart]lxz/

heightDfSupport=19;
widthDfSupport=5;

Jx[Properties of Ringlx/
heightDfRing=2;

widtnOfR1ng=20;

JiCreale cenler candle
module canclel) {
// Center stand
cylinder(lengtn,5);

rranslate( (0,9, length-candl251ze/2])
if(centerCandle){
differenca(){
$fn=069;
cylinder(candleSize, r=CerterCandlewidth);

linear_extrude.scad

candle-modified.scad

text_on_cube scad* recursion.scad
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CGAL Polyredrons in cache: 13
CGAL cache size in bytes: 20884776
Total rendering time. 0:00:04.524
Top level object is a 3D object:
Simple: yes
Vertices: 43N
Halfedges: 16406
Cdges: 8203
Halffacers: 7794
Facets: 3897
Volumes: Vi
Rendering finished.
STL export finished: /Users(jlhp2023/Library/CloudSterage/3ox-
Box/Pomonaf18DT lectures/openSCAD/candle-modif ed st

Viewport: translate = [ 47.68 45.38 35.13 ], rotate = [ 74.6C 350.90 27.80 ], distance = 450.85, fov = 22.80 (936x508)

polygon_areas.scad

assert.scac
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Final code:
union () {
rotate ([90,0,07) {
import ("elephant.stl");

translate ([22,-15,40]) {

candle () ;

When importing, make sure
the .stl is in the same folder/directory
as your .scad file

've also uploaded the files to Canvas



() & Prepare < Preview Device

(

Printer

Bambu Lab X1 Carbon 0.4 nozzle
Bed type Smooth PEI Plate / High Temp Plate

Filament

1 Bambu PLA Basic

Process  Global Advanced B

* 0.20mm Standard @BBL X1C

Support
Support
v
Type Normal(auto)
Threshold angle 30
On build plate only
Filament for Supports
Support/raft base Default
Support/raft interface Default

candle-modified

Project Slice plate Print plate

Color scheme Line Type
G1X118.813 Y77.831 F30000
M204 S2000
G1 F1200
G1 X120.91 Y75.735 E.09376
M204 S10000
G1 X120.696 Y75.399 F30000
M204 S2000

2 G1F1200
G1X118.813 Y77.282 E.08422
M204 S10000
G1 X118.813 Y76.733 F30000
M204 S2000
G1 F1200
G171 X120.148 Y75.399 E.05968
M204 S10000
G1 X119.599 Y75.399 F30000

I M204 S2000

2 G1F1200

G1X118.813 Y76.184 E.03513

G1 E-.65 F1800

) G1 F12000
G1 X119.52Y75.477 E-15

M981 SO P20000 ; close spaghett

OrcaSlicer software

Try to design your 3D print (or
rotate it on the plate) to
Minimize supports

Read the HMC 3D printer

specific manual for settings

https://docs.google.com/document/d/
1BIw200A6k90F|1Fr1DcnzEegh9250TBILK1Sixms
Zko/edit#heading=h.p7003digftst


https://docs.google.com/document/d/1Blw20OA6k90Fj1Fr1DcnzEegb925oTB9Lk1SixmsZko/edit#heading=h.p7o03diqftst
https://docs.google.com/document/d/1Blw20OA6k90Fj1Fr1DcnzEegb925oTB9Lk1SixmsZko/edit#heading=h.p7o03diqftst
https://docs.google.com/document/d/1Blw20OA6k90Fj1Fr1DcnzEegb925oTB9Lk1SixmsZko/edit#heading=h.p7o03diqftst

Break / Seminar



Class 7 recap

a 3D printer/laser cutter schedule ¥ (&)
File Edit View Insert Format Data Tools Extensions Help

[ ]
TODOS. Q 6 ¢ & F 100% ~ $ % 0 00 123 pefaul.. + —[10|+ B I

Al v Date

+ For Wednesday's class: B R S O B
+ Reading responses for design tools for digital = e
fabrication
+ Seminar by Naima & Hannoh
- By next Monday's class:

10/4/24
10/5/24

» PM3: Press Fit Kit (bring to class)
» Suggested deadline for PM4 storyboard (EOD)

- Communicate your intended laser cutter/3D printer

usage times on this spreadsheet
https://docs.google.com/spreadsheets/d/
1TGOmMpZD_rgYgemDi1-C_zj7itxvZb7H8AHI3LSAPaYk/edit?
gid=0#gid=0



https://docs.google.com/spreadsheets/d/1TGOmpZD_rqYqemDi1-C_zj7ifxvZb7H8AHl3LSAPaYk/edit?gid=0#gid=0
https://docs.google.com/spreadsheets/d/1TGOmpZD_rqYqemDi1-C_zj7ifxvZb7H8AHl3LSAPaYk/edit?gid=0#gid=0
https://docs.google.com/spreadsheets/d/1TGOmpZD_rqYqemDi1-C_zj7ifxvZb7H8AHl3LSAPaYk/edit?gid=0#gid=0

